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Adressaten dieses Papiers

o Anwender von Software, die zur Bereitstellung eines Datentragers/Datenpakets nach
GDPdU/GoBD aufgefordert werden.

¢ Entwickler von Software, die steuerrelevante Daten fiir die Datentrageriiberlassung nach
GDPdU/GoBD bereitstellen.

Zusammenfassung/Ziel

Nach § 147 Abs. 6 AO ist es der Finanzverwaltung mdglich, die Daten von elektronischen
Buchfuhrungssystemen ,digital zu prifen, entweder durch Datentrageriiberlassung und/oder
durch mittelbaren bzw. unmittelbaren Zugriff.

Fur die Datentrageruberlassung ist es notwendig, dass die Daten von dem steuerpflichtigen
Unternehmen (oder dem beauftragten Steuerberater, buchfiihrenden [Sub-]Unternehmen
etc.) in ,maschinell auswertbarer Form*“ auf geeigneten Datentragern bereitgestellt werden.

Unter dem Begriff der ,maschinellen Auswertbarkeit* versteht die Finanzverwaltung den
wabhlfreien Zugriff auf alle gespeicherten Daten einschlief3lich der Stammdaten und
Verknupfungen mit Sortier- und Filterfunktionen.

Um eine solche Auswertbarkeit oder Verwertbarkeit zu erreichen, ist es notwendig, dass die
Dateiformate fur die Datentragertberlassung definiert und standardisiert werden.

In diesem Dokument wird ein Verfahren vorgestellt, das die definierte und standardisierte
Datentragertiberlassung ermdglicht und einen Standard fur die Software-Industrie
beschreibt.

Bei Ruckfragen wenden Sie sich bitte per E-Mail an GDPdU@audicon.net oder informieren
Sie sich unter https://www.audicon.net.

Beschreibungsstandard GDPdU/GoBD 5
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Text von § 147 Abs. 6 AO

In der Fassung des Gesetzes zur Senkung der Steuersatze und zur Reform der
Unternehmensbesteuerung (Steuersenkungsgesetz — StSenkG) vom 23.10.2000 BGBI. |
2000 S. 1433:

(6) Sind die Unterlagen nach Absatz 1 mit Hilfe eines Datenverarbeitungssystems erstellt
worden, hat die Finanzbehdrde im Rahmen einer AufR3enprifung das Recht, Einsicht in
die gespeicherten Daten zu nehmen und das Datenverarbeitungssystem zur Prifung
dieser Unterlagen zu nutzen. Sie kann im Rahmen einer Aul3enprifung auch verlangen,
dass die Daten nach ihren Vorgaben maschinell ausgewertet oder ihr die gespeicherten
Unterlagen und Aufzeichnungen auf einem maschinell verwertbaren Datentrager zur
Verfiigung gestellt werden. Die Kosten tragt der Steuerpflichtige.

Datentrageriuiberlassung
Ein mogliches Szenario fur eine Steuerprifung mit Datentragertberlassung:

Ein Steuerprufer bekommt den Auftrag, ein Unternehmen zu prifen. Fir bestimmte
Prufungsfelder und Prifungszeitrdume beschliel3t der Steuerprifer, die Daten unter
Zuhilfenahme von Prifungssoftware zu analysieren. Entsprechend werden dem
Unternehmen die Prufung angekindigt und die Prifungsschwerpunkte bekanntgegeben. Der
Steuerprifer bittet das Unternehmen, die steuerlich relevanten Daten auf einem maschinell
auswertbaren Datentrager nach den Vorgaben der ,Grundsatze zum Datenzugriff und zur
Prifbarkeit digitaler Unterlagen” (GDPdU) gemaR BMF-Schreiben vom 16.07.2001 bzw. der
,Grundsatze zur ordnungsmafigen Fuhrung und Aufbewahrung von Bichern,
Aufzeichnungen und Unterlagen in elektronischer Form sowie zum Datenzugriff‘ (GoBD)
gemal BMF-Schreiben vom 28.11.2019 bereitzustellen.

Bei Prufungsbeginn erhalt der Steuerprifer einen Datentrager oder ein Datenpaket.

Gemalf seinem Prifungsschwerpunkt sucht der Prufer die entsprechenden Tabellen heraus
und liest diese ein. Auf dem Datentrager/in dem Datenpaket sind steuerrelevante Daten und
beschreibende Daten enthalten, um die Daten ohne weitere Erklarungen einlesen zu
kénnen. Sobald die Daten in die Analysesoftware importiert sind, fihrt der Steuerprufer eine
oder mehrere Analysen (teilweise durch Makros automatisiert) aus.

1. Fordert Datentrager/Datenpaket an
2. Liest Datentrager/Datenpaket ein
3. Fuhrt Analyse aus bzw. lasst Analyse-Makros ablaufen

Abbildung 1: Steuerprifer
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Aus Sicht des Unternehmens fallen bei dem oben beschriebenen Szenario folgende
Arbeitsschritte an:

¢ Ein Mitarbeiter initiiert die Datenextraktion bzw. den Export aus der
Produktionsdatenbank, wobei die Daten ggf. (automatisch) transformiert werden in dem
Sinne, dass die Datenorganisation, die Struktur der Tabellen oder Objekte geandert wird.

e Ebenso muss bei komprimierten oder verschliusselten Daten die Komprimierung bzw. die
Verschliisselung aufgehoben werden. Zu den steuerrelevanten Daten muss nun noch
eine Beschreibung in Form einer maschinenauswertbaren Datei erzeugt oder
hinzukopiert werden. Eine solche Datei muss in dem Fall bei der Bereitstellung erzeugt
werden, falls der Softwarehersteller nicht vorhersehen kann, welche Daten bei der
Prufung bereitgestellt werden sollen. Es kann eine statische Datei bereitgestellt werden,
falls im Voraus der Umfang und die Struktur der Daten feststehen.
Die Daten werden anschlielRend automatisch oder manuell auf einem beweglichen
Datentrager/in einem Datenpaket gespeichert.

e Extraktion * Organisation
| l I * Transformation :\?::lf:if](;;?:;n

» Komprimierung

Produktivsystem

* Bereitstellung

* SAP
e Datev

Priifer/in
* Infor

* Navision

* Oracle Financials
* Varial

* eigene Software
* andere

Abbildung 2: Datentrageriiberlassung
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Die Datenorganisation bei der Datentrageriiberlassung

Das BMF-Schreiben vom 16.07.2001 gibt den gepriften Unternehmen bei der technischen
Organisation des zu Uberlassenden Datentragers/Datenpakets grundsatzlich einen breiten
Spielraum.

Nachdem die Finanzverwaltung des Bundes und der Lander die in der Wirtschaftsprufung
verbreitete Analysesoftware IDEA beschafft hat, sind die Steuerprifer in der Lage, Daten
maschinell zu lesen und (automatisiert oder manuell gesteuert) zu verarbeiten. Die
Finanzverwaltung definiert nicht die Datenfelder und Inhalte, die bei der
Datentrageriiberlassung auf den Datentrager/in das Datenpaket gebracht werden.
Entsprechend ist es notwendig, dass Steuerpflichtige und/oder Hersteller von Software, die
steuerlich relevante Daten verarbeiten, selbst entscheiden, welche Daten bei der
Datentrageriiberlassung bereitgestellt werden. Dabei kénnen je nach EDV-System,
Software-Strukturen, Unternehmensstruktur und -groRe unterschiedliche Dateninhalte
sinnvoll und notwendig sein.

Um Ruckfragen durch den Steuerprifer zu den Dateninhalten und Formaten zu minimieren
oder unnotig zu machen, wird hier ein Verfahren beschrieben, das die Daten,
Datenstrukturen und Verknupfungen beschreibt und kommentiert.

Um die unterschiedlichen Datenstrukturen verarbeiten zu kénnen, stellt der Steuerpflichtige
bzw. sein Berater die steuerrelevanten Daten weitgehend denormalisiert zur Verfligung.
Zusatzlich liefert er eine maschinenauswertbare Beschreibung der Daten, Datenformate und
Verknipfungen. Das Dateiformat fur die steuerlich relevanten Daten wurde auf gangige
Standardformate festgelegt. Beides — steuerrelevante Daten und Beschreibungsdaten — wird
auf einem gemeinsamen Datentréger/in einem gemeinsamen Datenpaket bereitgestellt.

Steuerrelevante Daten

Datenpaket

1

Beschreibungsdatei:
Datenbeschreibung und- verknipfung

Abbildung 3: Datenorganisation
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Die unterstitzten Dateiformate flr die steuerlich relevanten Daten sind:

e VariableLength
e FixedLength

Damit ist es den Softwaresystemen maglich, bereits bestehende Exportfilter oder
Speicherungsmechanismen zu nutzen.

Die Finanzverwaltung erlaubt keine Installation von Spezialsoftware zur Entschliisselung
oder zum Dekomprimieren von Daten auf ihren Systemen. Insbesondere beim Postversand
von Datentragern ist jedoch zumindest das Verschliisseln von Daten aus
Datenschutzgrinden erforderlich. Im Beschreibungsstandard ist deshalb vorgesehen, z. B.
Programme zur Entschlisselung oder zum Dekomprimieren direkt vom Datentrager zu
starten, ohne dass sich diese auf dem System der Finanzverwaltung installieren.

Die Computer der Prifer sind mit Zugriffsschutz-Software und ggf. Anti-Viren-Software
ausgestattet. Die Funktionsfahigkeit dieser direkt aufgerufenen Programme sollte deshalb
vom Daten-Bereitsteller im Vorfeld geklart werden. Die Prifung auf Laufféhigkeit dieser
Routinen ist nicht Gegenstand des Beschreibungsstandards.

Die Rolle des Softwareherstellers

Im Folgenden wird als ,Softwarehersteller” — aus Sicht des steuerpflichtigen Unternehmens —
ein externer Lieferant von Software oder einer Datenverarbeitungsanlage inklusive
Programmen oder eine interne Abteilung, die entsprechende Programme bzw. Services
bereitstellt, angenommen.

Gemal den dargestellten Szenarien zur Betriebsprifung muss bei der Betriebsprifung u. a.
eine maschinenauswertbare Beschreibung der Daten und der Verknipfungen bereitgestellt
werden.

Die Beschreibungsdatei wird von einem Programm gelesen, das gemaR dieser
Beschreibung die Import-Funktion des Analyseprogramms des Steuerprifers steuert. Es
werden keine Operationen auf Datenbanken der Produktivsysteme ausgefihrt.

Der Hersteller der Programme bzw. Prozeduren, mit denen das steuerpflichtige
Unternehmen steuerrelevante Daten verarbeitet (Softwarehersteller), muss zusatzlich zu
einer Extraktionsfunktionalitat die Aufbereitung oder Bereitstellung der
Beschreibungsfunktionalitat sicherstellen.

Beschreibungsstandard GDPdU/GoBD 9



© audicon

Precision in Audit and Analytics

XML-basierter Beschreibungsstandard

Uberblick

XML ist die ,eXtensible Markup Language®. XML gibt nur einen generischen Satz von
Sprachelementen vor, so dass je nach Anwendungsfall eine eigene Sprache definiert werden
muss. Die jeweils neu formulierte Sprache kann durch Strukturinformationen und
Elementdefinitionen in einer DTD (Document Type Definition) maschinenlesbar hinterlegt
werden. Damit kann ein XML-Parser Uberprifen (validieren), ob ein XML-Dokument der
vereinbarten Sprache entspricht. Man unterscheidet also zwischen Sprachbeschreibung in
der DTD und den Inhalten in der XML-Instanz.

In der DTD selbst werden also keine Beschreibungsdaten fiir die Datentrageriberlassung
gespeichert, sondern in der XML-Datei index.xml. Die DTD beschreibt den Aufbau der Datei
index.xml.

Weiterfilhrende Informationen zu XML findet man auf https://www.w3.0rg.

Allgemeine Annahmen bzw. Voraussetzungen zur DTD

Es wird in der DTD davon ausgegangen, dass die steuerrelevanten Daten in Dateien
organisiert sind. Pro Tabelle wird genau eine Datei angenommen, so dass die Organisation
nach Datei und Tabelle physisch zusammenfallen.

Die Beschreibungsdaten flr die Datentrageriberlassung werden in einer Datei index.xml
gespeichert.

Die DTD muss sich in demselben Verzeichnis auf dem Datentrager/in dem Datenpaket
befinden wie die Datei index.xml.

Werden mehrere Datentrager (Medien) bereitgestellt, muss sich die Datei index.xml nur auf
dem ersten Datentrager befinden.

Beschreibungsstandard GDPdU/GoBD 10
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Technischer Ablauf des Importprozesses

Der Importprozess wird von einer Komponente gesteuert, die die Datei index.xml interpretiert
und die Exporttabellen von den einzelnen Datentragern/Datenpaketen an die Analyse-
Software tbergibt. Diese Komponente Uberprift die Datei index.xml auf Korrektheit und dient
dem Prufer als Inhaltsverzeichnis fur die gelieferten Daten.

GDPdU Interpreter

Analyse-
software

Abbildung 4: Importprozess

Beschreibungsstandard GDPdU/GoBD 11
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<?xml version="1.0" encoding="UTF-8"?>

<l--Versions available:

1.1 (August-01-2002)

-->

<l-- Start Simple Types -->

<l-- Supplementary Vocabulary -->

<IELEMENT Version (#PCDATA)>

<IELEMENT Location (#PCDATA)>

<IELEMENT Comment (#PCDATA)>

<IELEMENT Length (#PCDATA)>

<IELEMENT References (#PCDATA)>

<IELEMENT From (#PCDATA)>

<IELEMENT To (#PCDATA)>

<!I-- Specifying a maximum length for a VariableLength column can

reduce a VariableLength tables' import time. If MaxLength

is not specified then we parse URL to determine the MaxLength
for each column.

* Only applies to VariableLength tables. -->
<IELEMENT MaxLength (#PCDATA)>
<!I-- Specifies which character (if any) encapsulates a
VariableLength AlphaNumeric column.

Doublequote is the default TextEncapsulator "

* Only applies to VariableLength tables. (Optional) -->
<IELEMENT TextEncapsulator (#PCDATA)>

<!I-- Specifies how many  digits appear to the right of the decimal symbol.

CAUTION: Results are undefined when importing numeric data with
greater Accuracy than the Accuracy defined in index.xml

For example trying to import the value 1000,25 with an
accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.

Zero is the default Accuracy '0' (Optional)
-—->
<IELEMENT Accuracy (#PCDATA)>

<!-- The decimal place is not always stored with numbers. If each number

is supposed to have decimal places use ImpliedAccuracy -->
<IELEMENT ImpliedAccuracy (#PCDATA)>
<!-- Enables you to change how GDPdU displays dates.
DD.MM.YYYY is the default Format -->
<IELEMENT Format (#PCDATA)>
<!I-- Specifies the symbol that indicates decimal values.
Comma is the default DecimalSymbol. '’
Specified once per Table. -->
<IELEMENT DecimalSymbol (#PCDATA)>
<!I-- Specifies the symbol that groups the digits in large numbers.
Dot is the default DigitGroupingSymbol or ThousandsSeperator. "'
Specified once per Table -->
<IELEMENT DigitGroupingSymbol (#PCDATA)>
<l-- Command(s) are executed in the following manner
* before the import process
* after the import process
* before a Media is imported
* after a Media is imported
-—>
<IELEMENT Command (#PCDATA)>
<!I-- Only the file protocol is supported at this time.

* The standard uses relative URLSs.

Absolute URLs are not allowed. The following are all invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file://[Accounts.dat

Beschreibungsstandard GDPdU/GoBD
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The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* ..[Accounts.dat
->
<IELEMENT URL (#PCDATA)>
<l-- Textual description of specified element (Optional) -->
<IELEMENT Description (#PCDATA)>
<l-- The logical name of specified element.
Sometimes referred to business name.

If missing, URL will be used in place of Name. -->
<IELEMENT Name (#PCDATA)>
<I-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
<IELEMENT Epoch (#PCDATA)>
<I-- Element(s) that separate columns or records.
Semicolon is the default ColumnDelimiter. ;'
CRLF or &#13;&#10; is the default RecordDelimiter. -->
<IELEMENT ColumnDelimiter (#PCDATA)>
<IELEMENT RecordDelimiter (#PCDATA)>
<I-- The number of bytes skipped before reading of URL commences.
Zerois the default when not specified. '0'
-->
<IELEMENT SkipNumBytes (#PCDATA)>
<!-- End Simple Types -->
<l-- Start Complex Types -->
<!-- Self-explanatory -->
<IELEMENT Range (From, (To | Length)?)>
<IELEMENT FixedRange (From, (To | Length))>
<!-- The document element -->
<IELEMENT DataSet (Version, DataSupplier?, Command*, Media+, Command*)>
<!-- Supported datatypes (mandatory) -->
<IELEMENT AlphaNumeric EMPTY>
<IELEMENT Date (Format?)>
<IELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>
<!-- Supported codepages:
Be careful to explicitly define RecordDelimiter when using
a non-default codepage.

ANSI is the default codepage when not specified -->
<IELEMENT ANSI EMPTY>
<IELEMENT Macintosh EMPTY>
<IELEMENT OEM EMPTY>
<IELEMENT UTF16 EMPTY>
<IELEMENT UTF7 EMPTY>
<IELEMENT UTF8 EMPTY>
<!-- Supported file formats:
FixedLength

VariableLength -->
<IELEMENT FixedLength ((Length | RecordDelimiter)?, ((FixedPrimaryKey+, FixedColumn*) | (FixedColumn+)),
ForeignKey*)>
<IELEMENT FixedColumn (Name, Description?, (Numeric | AlphaNumeric | Date), Map*, FixedRange)>
<IELEMENT FixedPrimaryKey (Name, Description?, (Numeric | AlphaNumeric | Date), Map*, FixedRange)>
<IELEMENT VariableLength (ColumnDelimiter?, RecordDelimiter?, TextEncapsulator?, ((VariablePrimaryKey+,
VariableColumn*) | (VariableColumn+)), ForeignKey*)>
<IELEMENT VariableColumn (Name, Description?, (Numeric | (AlphaNumeric, MaxLength?) | Date), Map*)>
<IELEMENT VariablePrimaryKey (Name, Description?, (Numeric j (AlphaNumeric, MaxLength?) | Date), Map*)>
<!-- Description of the entity supplying the data. (Optional) -->
<IELEMENT DataSupplier (Name, Location, Comment)>
<!-- The first Media will contain index.xml. Importing will process each media listed -->
<IELEMENT Media (Name, Command*, Table+, Command*)>
<!-- Elements common to FixedLength & VariableLength are propagated to Table. -->
<IELEMENT Table (URL, Name?, Description?, Validity?, (ANSI | Macintosh | OEM | UTF16 | UTF7 | UTF8)?,
(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?, Range?, Epoch?, (VariableLength | FixedLength))>
<!-- ForeignKeys denote joins or relationships between tables.

To successfully join two tables make sure both the PrimaryKey

and the referenced column (foreignkey) are of the same datatype.

Results are undefined when joining two tables with different

key datatypes. Most likely an error will occur -->
<IELEMENT ForeignKey (Name+, References)>
<l- Maps AlphaNumeric columns from 'From' to To'

i.e. From To

Beschreibungsstandard GDPdU/GoBD 13
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True 1
True -1
False 0

The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric -> AlphaNumeric

Date -> AlphaNumeric

AlphaNumeric -> Date

AlphaNumeric -> Numeric
-->
<IELEMENT Map (Description?, From, To)>
<!-- Documentation for table validity. -->
<IELEMENT Validity (Range, Format?)>
<!-- End Complex Types -->

Basically, a map is an associative container.

Abbildung 5: XML-DTD

Beschreibungsstandard GDPdU/GoBD
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Organisation des Beschreibungsstandards

XML
= version 1.0

= encoding UTF-5
:| DOCTYPE DataSet

4 DataSet
{} Version 10
| DataSupplier
{} Hame Glaswerk AG
{} Location SingenDeutschiand
_| {} Comment Datertraegeriberlazsung nach GOPU vom 14, August 2002, Dr. Grassle, Tel 07544 934265
Media (2)
{} Hame {3} Table
1 CD Mummer 1§+ Table
> Table
2 CD Mummer 2| > Table
> Table
> Table
4 Table
{3} URL hestelungen oy
{} Hame Bestellungen
{3} Description Bestellunoen-Bevegunogsdaten
- VariableLength
| VariableColumn (5]

.3

{}Hame  {} AlphaHumeric {} Date {} Humeric|
1 Arikel-Mr
2 Kunden-Code
3 Besteldatum Date
€} Format v MMDD
4 Lieferdatum Date
€} Format v MMDD
5 Besteldatum Date

{} Format v Y MMDD
| 6 Frachtkozten

B Coparmerd weeitere columns...
ForeignKey (2]
{}Hame  {}References
1 Kunden-Code Kunden
| [ _ 2 | Atikel-D Artikel

-]

.3

Abbildung 6: Beschreibungsstandard — Organisation

Das Basiselement des Beschreibungsstandards ist das DataSet-Element. Hier enthalten sind
die Elemente Version, DataSupplier, Command und Media.

e Version enthéalt die Versionsnummer der Datentragerbereitstellung.

e DataSupplier enthalt Angaben Uber die Herkunft der Daten.

¢ Die Media-Container enthalten die Angaben Uber die bereitgestellten Datentrager und die
Tabellen, die darauf gespeichert sind. Hierbei wird flr jedes bereitgestellte
Datentragermedium ein eigener Media-Eintrag vorgenommen. Somit ist es moglich, auch
mehrere Datentrager in einem DataSet zusammenzufassen.

Beschreibungsstandard GDPdU/GoBD 15
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Version

[ 1]

,FixedLength

Abbildung 7: Beschreibungsstandard — DataSet

Beschreibungsstandard GDPdU/GoBD
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fRecordDelimiter

FizedLength

i ———
oo

References

[ ]

Abbildung 8: Beschreibungsstandard — FixedLength
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Description !

ImpliedAccuracy

E]

,\lariahlePrimaryK F

ImpliedAccuracy

VariableLength

Accuracy

E]

1.

References

Abbildung 9: Beschreibungsstandard — VariableLength
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Hinweise zu XML

e Hinweis zu den in XML tblichen Operatoren:
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Operator Elementtyp darf auftreten
? 0-mal oder 1-mal

* 0-mal oder beliebig oft

+ 1-mal oder beliebig oft

Tabelle 3: Ubersicht tiber die géangigen Operatoren

o #PCDATA steht fiir Parsed Character Data und bedeutet, dass das Element fiir einen

Texteintrag vorgesehen ist.

o Bei Aufzadhlungen werden die mdglichen Werte durch senkrechte Striche (,|“) getrennt.
In XML muss auf Grof3- und Kleinschreibung geachtet werden.

¢ Bitte verwenden Sie in den Beschreibungsfeldern und/oder den Tabellen- und
Spaltennamen keines der folgenden Zeichen: " & < >

Verwenden Sie stattdessen den Namen oder die Nummer aus der untenstehenden Liste.

Zeichen Name Nummer
" &quot; &#34,
& &amp; &#38;
< &lt; &#60;
> &gt; &#62;

Tabelle 4: Liste der Namen und Nummern fir die Zeichen " & < >
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Beschreibung der Elemente
Es folgt eine Beschreibung der einzelnen ELEMENT-Deklarationen.
Im Allgemeinen gilt, dass die in den jeweiligen Attributen ,description” hinterlegten Texte

dem Prifer als Kommentar angezeigt werden. Die Lange des Textes in den description-
Attributen sollte 255 Zeichen nicht tGiberschreiten.

<IELEMENT Version (#PCDATA)>

Enthalt die Versionsnummer der Datentragerbereitstellung. Dieses Element hat keine
technische Auswirkung, sondern dient zur Beschreibung.

Verwendet in Container Kontextabhangige Beschreibung
DataSet

Tabelle 5: ELEMENT Version

<IELEMENT Location (#PCDATA)>
Beschreibt den Standort des Datenlieferanten.

Verwendet in Container Kontextabhangige Beschreibung
DataSupplier

Tabelle 6: ELEMENT Location

<IELEMENT Comment (#PCDATA)>
Kommentarfeld flir zusatzliche Informationen zum Datenlieferanten.

Verwendet in Container Kontextabhangige Beschreibung

DataSupplier

Tabelle 7: ELEMENT Comment

<!I[ELEMENT Length (#PCDATA)>
Enthalt Informationen Uber die Lange von Attributen oder Datensatzen.

Verwendet in Container Kontextabhangige Beschreibung

Range

Tabelle 8: ELEMENT Length
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<I[ELEMENT References (#PCDATA)>
Enthalt Informationen Uber Verknipfungen.

Verwendet in Container Kontextabh&angige Beschreibung

ForeignKey referenzierte Tabelle

Tabelle 9: ELEMENT References

Siehe hierzu auch das Beispiel auf Seite 38.

<I[ELEMENT From (#PCDATA)>
Enthalt Informationen tber den Startwert eines Wertebereichs.

Verwendet in Container Kontextabhangige Beschreibung
Range Startwert in einem Wertebereich
Map Redefinition von Daten

Tabelle 10: ELEMENT From

<I[ELEMENT To (#PCDATA)>
Enthalt Informationen Gber den Endwert eines Wertebereichs.

Verwendet in Container Kontextabhangige Beschreibung
Range Endwert in einem Wertebereich
Map Redefinition von Daten

Tabelle 11: ELEMENT To

<IELEMENT MaxLength (#PCDATA)>

Enthalt Informationen Uber die maximale Lange eines alphanumerischen Feldes in einer
VariableLength-Tabelle.

Verwendet in Container Kontextabhangige Beschreibung
VariableColumn Maximale Lange des Feldes
VariablePrimaryKey Maximale Lange des Feldes

Tabelle 12: ELEMENT MaxLength

Die Angabe von MaxLength bei dem Dateityp VariableLength beschleunigt den
Importprozess, da andernfalls die Datei vor dem Importprozess gepriift wird und die
maximalen Langen der Felder ermittelt werden.
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<I[ELEMENT TextEncapsulator (#PCDATA)>

Bei VariableLength-Dateien kann man Textfelder durch ein ,Encapsulator-Zeichen
einschlieRen, z. B. fur den Fall, dass der Feldtrenner in den Daten vorkommt.

Vorgabewert: "

Verwendet in Container Kontextabh&angige Beschreibung

VariableLength

Tabelle 13: ELEMENT TextEncapsulator

<IELEMENT Accuracy (#PCDATA)>

Anzahl der Nachkommastellen. Vorsicht bei Daten, deren Genauigkeit gréR3er ist, als in
Accuracy angegeben.

Vorgabewert: O

Verwendet in Container Kontextabhangige Beschreibung

Numeric

Tabelle 14: ELEMENT Accuracy

<IELEMENT ImpliedAccuracy (#PCDATA)>

Anzahl der Nachkommastellen, auch wenn in den Quelldaten keine Nachkommastellen
angegeben sind.

Beispiel:
Quelldaten: ,100; 200; 102; 5000; 6587890
ImpliedAccuracy 3:,0,100; 0,200; 0,102; 5,000; 6587,890°

Verwendet in Container Kontextabhangige Beschreibung

Numeric

Tabelle 15: ELEMENT ImpliedAccuracy
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<I[ELEMENT Format (#PCDATA)>
Angabe Uber Formatdefinitionen.

Vorgabewert: DD.MM.YYYY

Verwendet in Container Kontextabh&angige Beschreibung

Date Hier wird die Maskierung fir die Darstellung
von Datumsangaben hinterlegt.

Folgende Angaben fir Format sind gultig:

e DD flr Tag,
e MM fUr Monat,
e YY bzw. YYYY fur Jahr.

Beispiel (30. September 2001)

MM/DD/YY: 09/30/01
DD.MM.YY: 30.09.01
MM/DD/YYYY: 09/30/2001
YYYY-MM-DD: 2001-09-30
DDMMYY: 300901
DDMMYYYY: 30092001

Validity Maskierung fur das verwendete
Datumsformat (siehe Date)

Tabelle 16: ELEMENT Format

<IELEMENT DecimalSymbol (#PCDATA)>
Angabe Uber das Dezimalstellen-Trennzeichen.

Vorgabewert: ,

Verwendet in Container Kontextabhangige Beschreibung

Table

Tabelle 17: ELEMENT DecimalSymbol

<I[ELEMENT DigitGroupingSymbol (#PCDATA)>
Definiert das Tausender-Trennzeichen.

Vorgabewert: .

Verwendet in Container Kontextabhangige Beschreibung

Table

Tabelle 18: ELEMENT DigitGroupingSymbol
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<IELEMENT Command (#PCDATA)>

Definiert ein Betriebssystemkommando. Commands kdnnen an folgenden Stellen ausgefiuhrt
werden:

e vor dem gesamten Importprozess

e nach dem gesamten Importprozess

e Dbevor ein einzelner Datentrager importiert wird

¢ nachdem ein einzelner Datentréger importiert wurde
Verwendet in Container Kontextabhangige Beschreibung
DataSet Command fir den gesamten Vorgang
Media Command fiir einen einzelnen Datentréger

Tabelle 19: ELEMENT Command

Siehe hierzu auch das Beispiel auf Seite 40.

<I[ELEMENT URL (#PCDATA)>
Dieses Element enthalt den physischen Dateinamen der bereitgestellten Datei.

In dieser Version des Beschreibungsstandards werden ausschlielich relative URLs
unterstitzt. Als Basisverzeichnis gilt der Pfad zur Datei index.xml.

Beispiele fur ungultige Eintrage:
http://www.somewhere.com/data/Accounts.csv
ftp://fftp.somewhere.com/data/Accounts.csv

Beispiele fur glltige Eintrage:
Accounts.dat
data/Accounts.dat
data/january/Accounts.dat
../Accounts.dat

Verwendet in Container Kontextabhangige Beschreibung

Table

Tabelle 20: ELEMENT URL
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Verwendet in Container

Kontextabhangige Beschreibung

FixedColumn Beschreibungsfeld fiir Spalten in
FixedLength-Dateien
FixedPrimaryKey Beschreibungsfeld fur Schlussel in

FixedLength-Dateien

VariableColumn

Beschreibungsfeld fir Spalten in
VariableLength-Dateien

VariablePrimaryKey Beschreibungsfeld fiir Schlissel in
VariableLength-Dateien

Table Beschreibungsfeld fur Tabellen

Map Beschreibungsfeld fur Redefinition von

Daten

Tabelle 21: ELEMENT Description

<I[ELEMENT Name (#PCDATA)>
Beschreibungsfeld

Vorgabewert: Angabe aus dem URL-Element

Verwendet in Container

Kontextabhangige Beschreibung

FixedColumn

Spaltenname in FixedLength-Dateien

FixedPrimaryKey Schlisselname in FixedLength-Dateien
VariableColumn Spaltenname in VariableLength-Dateien
VariablePrimaryKey Schlisselname in VariableLength-Dateien

DataSupplier

Name des Datenlieferanten
(Firmenname, ...)

Media Datentrédger-Name
URL Physischer Tabellenname
ForeignKey Name des Fremdschlissels

Tabelle 22: ELEMENT Name
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Fur Daten, die eine 2-ziffrige Jahresangabe haben, kann ein Standardplatzhalter definiert
werden, der 19xx von 20xx trennt. Dieser Wert ist mit 30 vorbelegt.

In einigen Dateien konnte das Datum 25. November 55 entweder 1955 oder 2055 bedeuten.
Mit Epoch wird eingestellt, bis zu welchem zweistelligen Wert das Jahr als im n&chsten
Jahrhundert liegend interpretiert werden soll. Steht beispielsweise im Feld Jahrhundert-
Trennwert der Wert 50, so werden alle Jahresangaben von 0 bis 49 als die Jahre 2000 bis
2049, die Jahresangaben 50 bis 99 als 1950 bis 1999 interpretiert.

Vorgabewert: 30

Verwendet in Container

Kontextabhangige Beschreibung

Table

Tabelle 23: ELEMENT Epoch

<IELEMENT ColumnDelimiter(#PCDATA)>

Definiert Trennzeichen fur Datenfelder.

Vorgabewert: &#59; (Semikolon ,;“)

Verwendet in Container

Kontextabhangige Beschreibung

VariableLength

Datenfeld-Trennzeichen

Tabelle 24: ELEMENT ColumnDelimiter

Beispiel fur Ubliche Trennzeichen:

Trennzeichen XML-Notation
Komma ,,” &#t44;
Semikolon ,;“ &#59;

Tab &#9;

Tabelle 25: ELEMENT ColumnDelimiter — Liste gangiger Trennzeichen
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<I[ELEMENT RecordDelimiter (#PCDATA)>

Definiert Trennzeichen fur Datensatze.

Vorgabewert: &#13;&#10; (CRLF)

Verwendet in Container

Kontextabhangige Beschreibung

FixedLength

Datensatz-Trennzeichen

VariableLength

Datensatz-Trennzeichen

Tabelle 26: ELEMENT RecordDelimiter

Beispiel fur Ubliche Trennzeichen:

Trennzeichen

XML-Notation

CR Carriage Return &#13;
CRLF &#13;&#10;
LF Linefeed &#10;

Tabelle 27: ELEMENT RecordDelimiter — Liste gangiger Trennzeichen

<IELEMENT SkipNumBytes (#PCDATA)>

Falls eine Datei am Beginn unerwinschte Daten enthéalt, wie z. B. Datei-Header, ist hier
anzugeben, wie viele Bytes Ubersprungen und nicht gelesen werden sollen.

Vorgabewert: 0

Verwendet in Container

Kontextabhangige Beschreibung

Table

Tabelle 28: ELEMENT SkipNumBytes

<I[ELEMENT Range (From, (To | Length)?)>

Definiert einen Bereich oder einen Startwert.

Startwert bedeutet: Wird kein To oder Length angegeben, definiert dieser Range nur einen

Startwert (z. B. eine Datensatzposition).

Verwendet in Container

Kontextabhangige Beschreibung

Table

Startdatensatz

Validity

Glltigkeitsbereich

Tabelle 29: ELEMENT Range
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<I[ELEMENT FixedRange (From, (To | Length))>
Definiert einen Bereich mit Angabe von From und To oder From und Length.

Verwendet in Container Kontextabhangige Beschreibung
FixedColumn Feldposition in FixedLength-Dateien
FixedPrimaryKey Schlisselposition in FixedLength-Dateien

Tabelle 30: ELEMENT FixedRange

<I[ELEMENT DataSet (Version, DataSupplier?, Command*, Media+,
Command*)>

Das Element DataSet ist das oberste Element (document-Element) in der Hierarchie des
XML-Dokumentes. Das Element DataSet ist Trager der Version, Datenherkunft, Vorlauf- und
Nachlauf-Prozesse und der Medien, die die Tabellen enthalten.

<IELEMENT AlphaNumeric EMPTY>
Definiert den Datentyp als alphanumerisch.

Verwendet in Container Kontextabhangige Beschreibung

FixedColumn Typ des Feldes in FixedLength-Datei

FixedPrimaryKey Typ des Schlissels in FixedLength-Datei

VariableColumn Typ des Feldes in VariableLength-Dateien

VariablePrimaryKey Typ des Schlissels in VariableLength-
Dateien

Tabelle 31: ELEMENT AlphaNumeric

<I[ELEMENT Date (Format?)>
Definiert den Datentyp als Datum.

Verwendet in Container Kontextabhangige Beschreibung

FixedColumn Typ des Feldes in FixedLength-Datei

FixedPrimaryKey Typ des Schlissels in FixedLength-Datei

VariableColumn Typ des Feldes in VariableLength-Dateien

VariablePrimaryKey Typ des Schliissels in VariableLength-
Dateien

Tabelle 32: ELEMENT Date
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<IELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

Definiert den Datentyp als numerisch.

Verwendet in Container

Kontextabhangige Beschreibung

FixedColumn Typ des Feldes in FixedLength-Datei
FixedPrimaryKey Typ des Schlissels in FixedLength-Datei
VariableColumn Typ des Feldes in VariableLength-Dateien
VariablePrimaryKey Typ des Schlissels in VariableLength-

Dateien

Tabelle 33: ELEMENT Numeric

<I[ELEMENT ANSI EMPTY>

Legt die Verwendung der Codepage ANSI fest.

<I[ELEMENT Macintosh EMPTY>

Legt die Verwendung der Codepage Macintosh fest.

<I[ELEMENT OEM EMPTY>

Legt die Verwendung der Codepage IBM-PC-ASCII fest.

<I[ELEMENT UTF16 EMPTY>

Legt die Verwendung der Codepage UTF16 fest.

<I[ELEMENT UTF7 EMPTY>

Legt die Verwendung der Codepage UTF7 fest.
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<IELEMENT UTF8 EMPTY>
Legt die Verwendung der Codepage UTF8 fest.

Vorgabewert: ANSI
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Plattform

Zeichensatz

Unix-Rechner

7-Bit-ASCIl-Zeichensatz (7-Bit-ISO Code,
US-Variante), nur Zeichen mit ASCII-Code
kleiner 128, also Buchstaben, Ziffern und
Sonderzeichen (Punkt, Komma etc.) ohne
nationale Sonderzeichen (Umlaute etc.) und
ohne Grafikzeichen. Zeilentrenner ist LF
(Line Feed), das Zeichen 10.

PC unter DOS

8-Bit-Zeichensatz ,IBM-PC-ASCII, der in
den unteren 127 Zeichen dem 7-Bit-ASCII
entspricht und ab Zeichen 128 nationale
Sonderzeichen und (Semi-)Grafikzeichen
enthalt. Zeilentrenner ist die Folge CR und
LF, das sind die Zeichen 12 und 10
(Carriage Return, Line Feed).

PC unter Windows

8-Bit-ANSI-Zeichensatz, der bis 127 ASCII
entspricht und oberhalb 127 nationale
Sonderzeichen enthalt, die nicht mit denen
des IBM-PC-ASCII Ubereinstimmen.
Zeilentrenner ist wie unter DOS die Folge
CR, LF. (Spezielle Anwendungen kdnnen
auch einen 16-Bit-Code, den Unicode,
benutzen.)

Apple Mac

Mac-spezifischer 8-Bit-Zeichensatz ,Mac-
ASCII¥, der bis 127 ASCII entspricht und
oberhalb 127 nationale Sonderzeichen
enthéalt. Zeilentrenner ist CR.

Tabelle 34: ELEMENT UTF8

Die Wahl der Codepage setzt keine Vorgabe fir den RecordDelimiter. Sie miissen den
RecordDelimiter immer explizit angeben, wenn der Vorgabewert (CRLF) nicht geeignet ist.
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<I[ELEMENT FixedLength ((Length | RecordDelimiter)?, ((FixedPrimaryKey+,
FixedColumn?*) | (FixedColumn+)), ForeignKey*)>

Definiert eine Datei vom Typ FixedLength.

Verwendet in Container

Kontextabhangige Beschreibung

Table

Tabelle 35: ELEMENT FixedLength

<IELEMENT FixedColumn (Name, Description?, (Numeric | AlphaNumeric |

Date), Map*, FixedRange)>

Definiert eine Spalte (= Column) in einer Datei vom Typ FixedLength.

Verwendet in Container

Kontextabhangige Beschreibung

FixedLength

Tabelle 36: ELEMENT FixedColumn

<IELEMENT FixedPrimaryKey (Name, Description?, (Numeric | AlphaNumeric |

Date), Map*, Range)>

Definiert ein Schlusselfeld (= Key) in einer Datei vom Typ FixedLength.

Verwendet in Container

Kontextabhangige Beschreibung

FixedLength

Tabelle 37: ELEMENT FixedPrimaryKey

Siehe hierzu auch das Beispiel auf Seite 38.

<!I[ELEMENT VariableLength (ColumnDelimiter?, RecordDelimiter?,
TextEncapsulator?, ((VariablePrimaryKey+, VariableColumn®) |

(VariableColumn+))?, ForeignKey*)>
Definiert eine Datei vom Typ VariableLength.

Verwendet in Container

Kontextabhangige Beschreibung

Table

Tabelle 38: ELEMENT VariableLength

Die Felder (VariableColumn, VariablePrimaryKey) missen in der Reihenfolge definiert

werden, in der sie in der Datei geliefert werden.
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<I[ELEMENT VariableColumn (Name, Description?, (Numeric | AlphaNumeric,

MaxLength ? | Date), Map*)>

Definiert eine Spalte (= Column) in einer Datei vom Typ VariableLength.

Verwendet in Container

Kontextabhangige Beschreibung

VariableLength

Tabelle 39: ELEMENT VariableColumn

Die Felder (VariableColumn, VariablePrimaryKey) missen in der Reihenfolge definiert

werden, in der sie in der Datei geliefert werden.

<IELEMENT VariablePrimaryKey (Name, Description?, (Numeric |
AlphaNumeric, MaxLength ? | Date), Map*)>
Definiert ein Schlusselfeld (= Key) in einer Datei vom Typ VariableLength.

Verwendet in Container

Kontextabhangige Beschreibung

VariableLength

Tabelle 40: ELEMENT VariablePrimaryKey

Die Felder (VariableColumn, VariablePrimaryKey) missen in der Reihenfolge definiert

werden, in der sie in der Datei geliefert werden.

Zu Verknupfungen siehe auch das Beispiel auf Seite 38.

<I[ELEMENT DataSupplier (Name, Location, Comment)>

Enthalt Angaben zum Datenlieferanten.

Verwendet in Container

Kontextabhangige Beschreibung

DataSet

Lieferant (Firma, ...)

Tabelle 41: ELEMENT DataSupplier

<I[ELEMENT Media (Name, Command*, Table+, Command*)>

Definiert den Inhalt eines Datentragers.

Verwendet in Container

Kontextabhangige Beschreibung

DataSet

Datentrégeruberlassung

Tabelle 42: ELEMENT Media
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<I[ELEMENT Table (URL, Name?, Description?, Validity?, (ANSI | Macintosh |
OEM | UTF16 | UTF7 | UTF8)?, (DecimalSymbol, DigitGroupingSymbol)?,
SkipNumBytes?, Range?, (VariableLength | FixedLength)?)>

Definiert eine Tabelle.

Verwendet in Container

Kontextabhangige Beschreibung

Media

Tabelle

Tabelle 43: ELEMENT Table

<IELEMENT ForeignKey (Name+, References)>

Definiert eine Spalte als Fremdschlissel.

Die Spalte, auf die mit Namen Bezug genommen wird, muss in der gleichen Table als
FixedColumn oder VariableColumn definiert sein.

Verwendet in Container

Kontextabhangige Beschreibung

FixedLength Feld in FixedLength-Datei, referenzierte
Tabelle
VariableLength Feld in VariableLength-Datei, referenzierte

Tabelle

Tabelle 44: ELEMENT ForeignKey

Siehe hierzu auch das Beispiel auf Seite 38.
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<I[ELEMENT Map (Description?, From, To)>
Mit dem Element Map kdnnen Redefinitionen auf Datenebene vorgenommen werden.

Beispiel:
From (Ausgangsdaten) To (Zieldaten)
1 wahr
0 falsch
Hr Herr
Fr Frau
01 verheiratet
02 ledig
03 Steuerklasse 3

Tabelle 45: ELEMENT Map — Redefinitionen

Verwendet in Container

Kontextabhangige Beschreibung

FixedColumn

Feld in FixedLength-Datei

FixedPrimaryKey Schlissel in FixedLength-Datei
VariableColumn Feld in VariableLength-Dateien
VariablePrimaryKey Schlissel in VariableLength-Dateien

Tabelle 46: ELEMENT Map

Map darf nur fir alphanumerische Felder benutzt werden.

Sie sollten vermeiden, in der Datentrageriberlassung kodierte Felder zu liefern, sondern alle
Codes in die textuelle Beschreibung umwandeln. Wenn diese Umwandlung nicht bereits von
dem Exportprogramm vorgenommen wird, ist Map eine Moglichkeit, Codes Uber die

Datenbeschreibung umzuwandeln.

<IELEMENT Validity (Range, Format?)>

Definiert den Gultigkeitszeitraum der Daten.

Verwendet in Container

Kontextabhangige Beschreibung

Table

Glltigkeitszeitraum

Tabelle 47: ELEMENT Validity
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Beispiel 1 fur eine Datei index.xml

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE DataSet SYSTEM "gdpdu-01-08-2002.dtd">
<DataSet>
<Version>1.0</Version>
<DataSupplier>
<Name>Glaswerk AG</Name>
<Location>Singen/Deutschland</Location>
<Comment>Datentraegeriiberlassung nach GDPdU vom 14.August 2002, Dr. Grassle, Tel: 07544
934266</Comment>
</DataSupplier>
<Media>
<Name>CD Nummer 1</Name>
<Table>
<URL>Account.csv</URL>
<Name>Account</Name>
<Description>Accounts Receivables</Description>
<!-- Diese Tabelle gilt von 1.Januar 2000- 31.Dezember 2002 -->
<Validity>
<Range>
<From>20000101</From>
<T0>20021231</To>
</Range>
<Format>YYYYMMDD</Format>
</Validity>
<!-- Spezifiziert den Dezimaltrenner -->
<DecimalSymbol>.</DecimalSymbol>
<!-- Spezifiziert den Tausender-Separator -->
<DigitGroupingSymbol>,</DigitGroupingSymbol>
<VariableLength>
<!-- ein zusammengesetzter Primaerschlissel -->
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariablePrimaryKey>
<Name>ld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Account Description</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Balance</Name>
<Numeric/>
</VariableColumn>
<VariableColumn>
<Name>Old Balance</Name>
<Numeric/>
</VariableColumn>
</VariableLength>
</Table>
<Table>
<URL>Region.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Description</Name>
<AlphaNumeric/>
</VariableColumn>
</VariableLength>
</Table>
</Media>
<Media>
<Name>CD Nummer 2</Name>
<Table>
<URL>Sales.csv</URL>
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<Range>
<From>56</From>
</Range>
<FixedLength>
<FixedPrimaryKey>
<Name>Salesld</Name>
<AlphaNumeric/>
<FixedRange>
<l-- Position des Feldes: -->
<From>1</From>
<T0>10</To>
</FixedRange>
</FixedPrimaryKey>
<FixedColumn>
<Name>Regionld</Name>
<AlphaNumeric/>
<FixedRange>
<From>11</From>
<Length>10</Length>
</FixedRange>
</FixedColumn>
<FixedColumn>
<Name>ld</Name>
<AlphaNumeric/>
<FixedRange>
<From>21</From>
<T0>30</To>
</FixedRange>
</FixedColumn>
<FixedColumn>
<Name>SalesComplete</Name>
<AlphaNumeric/>
<l-- Redefinition des Wertes "1" nach "True" und "0" nach "False" -->
<Map>
<From>1</From>
<To>True</To>
</Map>
<Map>
<From>0</From>
<To>False</To>
</Map>
<FixedRange>
<From>31</From>
<T0>32</To>
</FixedRange>
</FixedColumn>
<!I-- ein zusammengesetzter Fremdschluessel der den Primaerschluessel in Tabelle Account
referenziert -->
<ForeignKey>
<Name>Regionld</Name>
<Name>ld</Name>
<References>Account</References>
</ForeignKey>
</FixedLength>
</Table>
<Table>
<URL>kunden.csv</URL>
<Name>Kunden</Name>
<Description>Kunden-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Firma</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kontaktperson</Name>
<AlphaNumeric/>
</VariableColumn>
<!-- weitere columns... -->
</VariableLength>
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</Table>

<Table>
<URL>artikel.csv</URL>
<Name>Artikel</Name>

<VariableLength>
<VariablePrimaryKey>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Artikelname</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Lieferanten-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<l--weitere columns... -->
</VariableLength>
</Table>
<Table>
<URL>bestellungen.csv</URL>
<Name>Bestellungen</Name>

<VariableLength>
<VariableColumn>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Lieferdatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Bestelldatum</Name>
<Date>
<Format>YYYYMMDD</Format>
</Date>
</VariableColumn>
<VariableColumn>
<Name>Frachtkosten</Name>
<Numeric/>
</VariableColumn>
<!--weitere columns... -->
<ForeignKey>
<Name>Kunden-Code</Name>
<References>Kunden</References>
</ForeignKey>
<ForeignKey>
<Name>Artikel-ID</Name>
<References>Artikel</References>
</ForeignKey>
</VariableLength>
</Table>
</Media>
</DataSet>

<Description>Artikel-Stammdaten</Description>

<Description>Bestellungen-Bewegungsdaten</Description>

Abbildung 10: Beispiel 1 — Datei index.xml
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In der Datentrageruberlassung kann es sinnvoll sein, Bewegungsdaten und Stammdaten
nicht in einer breiten Tabelle zu liefern, sondern in getrennten Tabellen abzuspeichern:

Beispiel:
Kunden
Artikel
*
KUNDEN_CODE *
FIRMA ARTIKEL_NR
[KONTAKTPERSON ARTIKELNAME
IPOSITION LEEFERANTEN_NR
STRARE KATEGORIE_NR

oRT
REGION
Pz
LAND

Bestellungen

LEEFEREINHEIT

EINZELPREIS

e

ARTIKELNR

| KUNDEN_CODE
BESTELLDATUM

TELEFON
[TELEFAX

LIEFERDATUM

FRACHTKOSTEN
EMPFANGER
STRARE

-
BESTIMMUNGSLAND
EINZELPREIS
ANZAHL

RABATT

LAGERBESTAND
BESTELLTEEINHETEN
MINDESTBESTAND
AUSLAUFARTIKEL

Abbildung 11: Beispiel 2 — Tabellen mit Bewegungsdaten und Stammdaten

In den Stammdaten werden die Priméarschliissel beschrieben:

<Table>
<URL>kunden.csv</URL>
<Name>Kunden</Name>
<Description>Kunden-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Kunden-Code</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Firma</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Kontaktperson</Name>
<AlphaNumeric/>
</VariableColumn>
<!-- weitere columns... -->
</VariableLength>
</Table>

<Table>
<URL>artikel.csv</URL>
<Name>Artikel</Name>
<Description>Artikel-Stammdaten</Description>
<VariableLength>
<VariablePrimaryKey>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Artikelname</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>
<Name>Lieferanten-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<!-- weitere columns... -->
</VariableLength>
</Table>

Abbildung 12: Beispiel 2 — Stammdaten
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Die Bewegungsdaten beschreiben die Verkniipfungen zu den Stammdaten tber die Angabe

der Fremdschlusselbeziehung:

<Table>
<URL>bestellungen.csv</URL>
<Name>Bestellungen</Name>

<VariableLength>
<VariableColumn>
<Name>Artikel-Nr</Name>
<AlphaNumeric/>
</VariableColumn>
<VariableColumn>

<AlphaNumeric/>
</VariableColumn>
<VariableColumn>

<Date>

</Date>
</VariableColumn>
<VariableColumn>

<Date>

</Date>
</VariableColumn>
<VariableColumn>

<Date>

</Date>
</VariableColumn>
<VariableColumn>

<Numeric/>
</VariableColumn>
<!-- weitere columns... -->
<ForeignKey>

</ForeignKey>
<ForeignKey>
<Name>Artikel-Nr</Name>

</ForeignKey>
</VariableLength>
</Table>

<Description>Bestellungen-Bewegungsdaten</Description>

<Name>Kunden-Code</Name>

<Name>Bestelldatum</Name>

<Format>YYYYMMDD</Format>

<Name>Lieferdatum</Name>

<Format>YYYYMMDD</Format>

<Name>Bestelldatum</Name>

<Format>YYYYMMDD</Format>

<Name>Frachtkosten</Name>

<Name>Kunden-Code</Name>
<References>Kunden</References>

<References>Artikel</References>

Abbildung 13: Beispiel 2 — Bewegungsdaten

Bitte beachten Sie:

Wahrend die Beschreibung eines VariablePrimaryKey die Spalte vollstandig beschreibt,
definiert ForeignKey keine neue Spalte. Die im ForeignKey benutzte Spalte muss vorher
bereits als VariableColumn oder FixedColumn definiert worden sein.
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Beispiel 3 fur eine Datei index.xml (komprimierte Daten)

index.xml

<?xml version="1.0" encoding="UTF-8"?>
<IDOCTYPE DataSet SYSTEM "gdpdu-01-08-2002.dtd">
<DataSet>
<Version>1.2</Version>
<DataSupplier>
<Name>Audicon GmbH</Name>
<Location>Germany</Location>
<Comment>A compressed sample DataSet</Comment>
</DataSupplier>
<Command>uncompress.bat</Command>
<Media>
<Name>Disk 1</Name>
<Table>
<URL>dummy.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>dummy</Name>
<Numeric/>
</VariablePrimaryKey>
</VariableLength>
</Table>
</Media>
</DataSet>

Abbildung 14: Beispiel 3 — Datei index.xml

uncompress.bat
T = o m o oo o o
rem uncompress.bat
rem expandiert gdpdu.zip in das windows-temp-verzeichnis, unterverzeichnis gdpdu
T = o m o oo o o
mkdir %temp%\gdpdu
pkunzip gdpdu.zip %temp%\gdpdu

Abbildung 15: Beispiel 3 — Datei uncompress.bat

%temp% ist eine Betriebssystem-Umgebungsvariable, die den Pfad zum Temporar-
Verzeichnis reprasentiert.

Die Datei gdpdu.zip enthalt die gepackte Datentragerbereitstellung (einschlieZlich der Datei
index.xml und gdpdu-01-08-2002.dtd). Der Prifer 6ffnet nach dem Dekomprimieren also die
neue Datenbereitstellung in dem Verzeichnis % TEMP%\gdpdu.

Bitte beachten Sie:

Die <Version>-Angabe bezieht sich nicht auf die Version des Beschreibungsstandards,
sondern auf die Version der Datentrageriiberlassung.
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Haufig gestellte Fragen

e Missen wir die Daten im XML-Format liefern?
Nein. Nur die Beschreibung der Daten (Datei index.xml) ist im XML-Format. Die
Nutzdaten sind im FixedLength- oder VariableLength-Format.

e Kann Ihr System mit Daten in DOS/Unix/Mac-Formaten (Zeilentrenner) umgehen?
Ja, denn die Zeilentrenner kénnen explizit angegeben werden.

e Wie sind negative Zahlen darzustellen (vor/hinter der Zahl, Leerzeichen zwischen
Vorzeichen und Zahl erlaubt)?
Negativen Zahlen ist ein Minuszeichen ohne Leerstelle vor- oder nachzustellen (z. B.
,-1782,90“ oder ,1782,90-).

e Wenn eine Uberlassene Datei zu groB3 flr einen Datentrager ist, kann sie dann auf
mehrere Datentrager gesplittet werden?
Der Beschreibungsstandard sieht ein Splitten einer Datei nicht vor. In diesem Fall kénnen
Sie aber die Daten komprimieren oder ein Speichermedium mit gréRerer Kapazitat (z. B.
DVD) wahlen.

¢ Welchen XML-Parser verwenden Sie?
Wir verwenden Xerces (https://xerces.apache.org/xerces-c/).

e |Ist es ein Fehler, wenn ForeignKey eine Tabelle referenziert, die nicht im DataSet
enthalten ist, oder wirde der ForeignKey dann ignoriert werden?
Die Beschreibung der Verlinkungen muss mit den gelieferten Daten Ubereinstimmen,
andernfalls ist Ihre Datentragertberlassung nicht konsistent. Der Import-Prozess weist
den Prufer auf die Inkonsistenz hin.

e Was passiert, wenn in der Datei index.xml eine Tabelle beschrieben wird, die aber
anschlieBend nicht vorhanden ist?
Die Beschreibung der Dateien muss mit den gelieferten Dateien Ubereinstimmen,
andernfalls ist Ihre Datentragertberlassung nicht konsistent. Der Import-Prozess weist
den Prifer auf die Inkonsistenz hin.
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¢ Sind Commands zwingend erforderlich? Stellen Sie fir Commands
Umgebungsvariablen zur Verfigung?
Commands sind nicht zwingend erforderlich. Wenn eine BAT- oder CMD-Datei
aufgerufen wird, stehen die tblichen Betriebssystem-Umgebungsvariablen zur
Verfligung. Der Import-Prozess setzt selbst keine Umgebungsvariablen.

o Wie kann abschlieBend geprift werden, ob die Daten des
Datentragers/Datenpakets von Ihrem System eingelesen werden kénnen?
Die sichere Variante der Priifung ist der Import mit IDEA fir GDPdU/GoBD (IDEA +
SmartX). SmartV hilft Ihnen, die Beschreibungsstandard-Konformitéat der Datei index.xml
und der zu importierenden Daten zu Uberprifen.

Eine einfache Mdglichkeit, die XML-Datei auf ihre syntaktische Korrektheit zu testen, ist,
sie mit einem XML-fahigen Browser zu 6ffnen.

o Daich mit XML-Standards nicht vertraut bin, ist mir nicht klar, wie ich die Dateien
index.xml und gdpdu.dtd konkret aufzubauen habe. Ich habe Ihnen eine
VariableLength-Datei zugeschickt; kdnnen Sie mir die korrespondierende XML-
bzw. DTD-Datei erstellen?

Sie sollten sich Grundkenntnisse in XML aneignen, die DTD-Datei missen (durfen!) Sie
nicht modifizieren.

Die Beschreibung der Daten (in der Datei index.xml) sollte immer von der Stelle aus
geschehen, die die Datenhoheit besitzt, also vom Softwarehersteller oder
steuerpflichtigen Unternehmen.

Audicon unterstiitzt Sie bei der Uberpriifung, ob die Datentrageriiberlassung mit dem
Beschreibungsstandard Ubereinstimmt, und bei der Erstellung der Datei index.xml (siehe
https://www.audicon.net/consulting/dienstleistungspakete/).

¢ In einigen Pressemitteilungen werden auf3er VariableLength und FixedLength noch
zahlreiche weitere Dateiformate genannt. Welche Formate sind fir die
Datentragertberlassung relevant?
Die in einigen Artikeln genannten Dateiformate beziehen sich auf die originaren Import-
Moglichkeiten der Software IDEA.
Der Beschreibungsstandard ist aber produktunabhangig und unterstitzt in der aktuellen
Version nur die beiden allgemeingultigen Formate VariableLength und FixedLength.

e Muss die Datei gdpdu-01-08-2002.dtd mit auf dem Datentrager gespeichert
werden?
Ja. Ein Datentrager, der zur Datentrageriiberlassung dient, muss die Datei gdpdu-01-08-
2002.dtd, die Datei index.xml und alle Nutzdaten (z. B. T1.CSV, T2.CSV, T3.CSV,
T4.ASC) enthalten.
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e In einer VariableLength-Datei sind im ersten Datensatz die Feldnamen gespeichert.
Wie kann man den ersten Satz tberlesen?
Verwenden Sie die Range-Angabe im Table-Element:

<Table>
<Range>
<From>2</From>
</Range>
<URL>Region.csv</URL>
<VariableLength>
<VariablePrimaryKey>
<Name>Regionld</Name>
<AlphaNumeric/>
</VariablePrimaryKey>
<VariableColumn>
<Name>Description</Name>
<AlphaNumeric/>
</VariableColumn>
</VariableLength>
</Table>

Abbildung 16: Range-Angabe

e Wird durch die Angabe eines Zeichensatzes, z. B. UTF7 oder Macintosh, die
Angabe des Zeilenbegrenzers automatisch tUbersteuert?
Nein. Nur die explizite Angabe des Zeilenbegrenzers (RecordDelimiter) Ubersteuert den
Vorgabewert (CRLF).
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Synopse Beschreibungsstandard Version 1.0 und Version 1.1

Umbenennungen sind blau gekennzeichnet, neue oder geléschte Elemente rot.

Version 1.0 vom 10. Mai 2002 (6.6.2002)

Version 1.1 vom 1. August 2002

<?xml version="1.0" encoding="UTF-8"?>
<!--Versions available:

<?xml version="1.0" encoding="UTF-8"?>
<!--Versions available:

1.0 (May-10-2002) 1.1 (August-01-2002)

-——> -—>

<!-- Start Simple Types --> <!-- Start Simple Types -->

<!-- Supplementary Vocabulary --> <!-- Supplementary Vocabulary -->

<!ELEMENT Version (#PCDATA)> <!ELEMENT Version (#PCDATA)>

<!ELEMENT Location (#PCDATA)> <!ELEMENT Location (#PCDATA)>

<!ELEMENT Comment (#PCDATA)> <!ELEMENT Comment (#PCDATA)>

<!ELEMENT Length (#PCDATA)> <!ELEMENT Length (#PCDATA)>

<!ELEMENT References (#PCDATA)> <!ELEMENT References (#PCDATA)>

<!ELEMENT From (#PCDATA) > <!ELEMENT From (#PCDATA)>

<!ELEMENT To (#PCDATA)> <!ELEMENT To (#PCDATA)>
<!-- Specifying a maximum length for a VariablelLength column
can reduce a Variablelength tables' import time.
If MaxLength is not specified then we parse URL to determine
the MaxLength for each column.

* Only applies to VariableLength tables. -->

<!'ELEMENT MaxLength (#PCDATA)>

<!-- Specifies which character (if any) encapsulates a <!-- Specifies which character (if any) encapsulates a

CSV text column --> VariableLength AlphaNumeric column.

Doublequote is the default TextEncapsulator "
* Only applies to VariablelLength tables. (Optional) --

>

<!ELEMENT TextEncapsulator (#PCDATA)> <!ELEMENT TextEncapsulator (#PCDATA)>

<!-- Specifies how many digits appear to the right of <!-- Specifies how many digits appear to the right of the

the decimal symbol. --> decimal symbol.
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Version 1.0 vom 10. Mai 2002 (6.6.2002)

Version 1.1 vom 1. August 2002

<!ELEMENT Accuracy (#PCDATA)>

<!-- The decimal place is not always stored with
numbers. If each number is supposed to have decimal
places use ImpliedAccuracy -->

<!ELEMENT ImpliedAccuracy (#PCDATA)>

<!-- The first line in CSV URL contains column headers.

A value of False is interpreted if the element is

missing. Any columns specified in the XML file take

precedence over the file. This lets you override some

columns in the file and leave the others as they are.
-=>

<!ELEMENT NamesFirstRow EMPTY>

large numbers.
The default is implementation dependant.
Specified once per Table -->
<!ELEMENT DigitGroupingSymbol (#PCDATA)>

<!-- Command(s) are executed in the following manner

<!-- Enables you to change how gdpdu displays dates.
The default is implementation dependant. -->
<!ELEMENT Format (#PCDATA)>
<!-- Specifies the symbol that indicates decimal values.
The default is implementation dependant.
Specified once per Table. -->
<!ELEMENT DecimalSymbol (#PCDATA) >
<!-- Specifies the symbol that groups the digits in

CAUTION:
Results are undefined when importing numeric data with
greater Accuracy than the Accuracy defined in index.xml

For example trying to import the wvalue 1000,25 with an
accuracy of 0 might result in 1000 or an error. This
behavior is specific to the implementation.

Zero is the default Accuracy '0O' (Optional)

-—>

<!ELEMENT Accuracy (#PCDATA)>

<!-- The decimal place is not always stored with numbers. If

each number is supposed to have decimal places use
ImpliedAccuracy —-->

<!ELEMENT ImpliedAccuracy (#PCDATA)>

<!-- Enables you to change how gdpdu displays dates.
DD.MM.YYYY is the default Format -->

<!ELEMENT Format (#PCDATA)>
<!-- Specifies the symbol that indicates decimal values.
Comma is the default DecimalSymbol. ','
Specified once per Table. -->
<!ELEMENT DecimalSymbol (#PCDATA)>
<!-- Specifies the symbol that groups the digits in large

numbers. Dot is the default DigitGroupingSymbol or
ThousandsSeperator. '.'

Specified once per Table -->
<!ELEMENT DigitGroupingSymbol (#PCDATA) >

<!-- Command(s) are executed in the following manner
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Version 1.0 vom 10. Mai 2002 (6.6.2002)

Version 1.1 vom 1. August 2002

* before the import process
* after the import process
* before a Media is imported

* after a Media is imported
-—>

<!ELEMENT Command (#PCDATA)>
The root path is the path of Media

The following are all invalid
* http://www.somewhere.com/data/Accounts.csv

* ftp://ftp.somewhere.com/data/Accounts.csv
*

The following is valid.
* file://Accounts.csv

<!ELEMENT URL (#PCDATA) >

<!-- Textual description of specified element -->
<!ELEMENT Description (#PCDATA)>

<!-- The logical names of specified element -->

<!ELEMENT Name (#PCDATA)>

<!-- Y2K Window Any year before Epoch is 2000+
Default value 50. -->

<!-- Only the file protocol is supported at this time.

* before the import process
* after the import process
* before a Media is imported
* after a Media i1s imported
-—>

<!ELEMENT Command (#PCDATA) >

<!-- Only the file protocol is supported at this time.

* The standard uses relative URLs.

Absolute URLs are not allowed. The following are all
invalid:
* http://www.somewhere.com/data/Accounts.dat
* ftp://ftp.somewhere.com/data/Accounts.dat
* file://localhost/Accounts.dat
* file:///Accounts.dat

The following are valid examples
* Accounts.dat
* data/Accounts.dat
* data/january/Accounts.dat
* _./Accounts.dat
-—>

<!ELEMENT URL (#PCDATA)>

<!-- Textual description of specified element (Optional) -->
<!ELEMENT Description (#PCDATA)>

<!-- The logical name of specified element.
Sometimes referred to business name.
If missing, URL will be used in place of Name. -->
<!ELEMENT Name (#PCDATA) >
<!-- Y2K Window Any year before Epoch is 2000+
Default value 30. -->
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Version 1.0 vom 10. Mai 2002 (6.6.2002)

Version 1.1 vom 1. August 2002

<1ELEMENT Epoch (#PCDATA) >

<!-- Specifies the symbol that seperates CSV columns or

ASCITFixedLength records. -->
<!ELEMENT Delimiter (#PCDATA)>

<!-- The number of bytes skipped before reading of URL

commences. —-—>

<!ELEMENT SkipNumBytes (#PCDATA)>

<!-- End Simple Types -->
<!-- Start Complex Types —-->
<!-- Self-explanetory -->

<!ELEMENT Range (From, (To | Length)?)>

<!-- The document element -->

<!ELEMENT DataSet (Version, DataSupplier?, Command*,

Media+, Command*) >

<!-- Supported datatypes
AlphaNumeric is the default datatype when a
datatype is not defined. -->
<!ELEMENT AlphaNumeric EMPTY>
<!ELEMENT Date (Format?, Epoch?)>
<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!ELEMENT Epoch (#PCDATA)>

<!-- Element(s) that separate columns or records.
Semicolon is the default ColumnDelimiter. ';'
CRLF or &#13;&#10; is the default RecordDelimiter. -->
<!'ELEMENT ColumnDelimiter (#PCDATA)>
<!ELEMENT RecordDelimiter (#PCDATA)>

<!-- The number of bytes skipped before reading of URL
commences. Zero is the default when not specified. '0' -->

<!ELEMENT SkipNumBytes (#PCDATA) >

<!-- End Simple Types -->
<!-- Start Complex Types -->
<!-- Self-explanatory -->

<!ELEMENT Range (From, (To | Length)?)>
<!ELEMENT FixedRange (From, (To | Length))>

<!-- The document element -->
<!ELEMENT DataSet (Version, DataSupplier?, Command*, Media+,
Command*) >

<!-- Supported datatypes (mandatory) -->

<!ELEMENT AlphaNumeric EMPTY>
<!'ELEMENT Date (Format?)>
<!ELEMENT Numeric ((ImpliedAccuracy | Accuracy)?)>

<!-- Supported codepages:

Be careful to explicitly define RecordDelimiter when using a
non-default codepage.

ANSI is the default codepage when not specified -->
<!ELEMENT ANSI EMPTY>

<!ELEMENT Macintosh EMPTY>

<!ELEMENT OEM EMPTY>

<!ELEMENT UTFl16 EMPTY>

<!ELEMENT UTF7 EMPTY>

<!ELEMENT UTF8 EMPTY>

Beschreibungsstandard GDPdU/GoBD

47




© audicon

Precision in Audit and Analytics

Version 1.0 vom 10. Mai 2002 (6.6.2002)

Version 1.1 vom 1. August 2002

<!-- Supported file formats -->

<!ELEMENT ASCIIFixedLength ((Length | Delimiter)?,
((FixedPrimaryKey+, FixedColumn*) | (FixedPrimaryKey*,
FixedColumn+)), ForeignKey*)>

<!ELEMENT FixedColumn (Name, Description?, (Numeric |
AlphaNumeric | Date)?, Map*, Range)>

<!ELEMENT FixedPrimaryKey (Name, Description?, (Numeric
| AlphaNumeric | Date)?, Map*, Range)>

<!ELEMENT CSV (NamesFirstRow?, Delimiter?,
TextEncapsulator?, ((PrimaryKey+, Column*) |
(PrimaryKey*, Column+))?, ForeignKey*)>

<!ELEMENT Column (Name, Description?, (Numeric |
AlphaNumeric | Date)?, Map*)>

<!ELEMENT PrimaryKey (Name, Description?, (Numeric |
AlphaNumeric | Date)?, Map*)>

<!-- Description of the entity supplying the data.
(Optional) -->

<!ELEMENT DataSupplier (Name, Location, Comment) >

<!-- The first Media will contain index.xml. Importing

will process each media listed -->

<!ELEMENT Media (Name, Command*, Table+, Command*)>

<!-- Elements common to ASCCIIFIXEDLENGTH & CSV are
propagated to Table.
CSV is the default format if none is specified. -->

<!ELEMENT Table (URL, Name?, Description?, Validity?,

(DecimalSymbol, DigitGroupingSymbol)?, SkipNumBytes?,
Range?, (CSV | ASCIIFixedLength)?)>

<!-- ForeignKeys denote joins and relationships between
tables.

Not specifying ForeignKeys prevent joins from
occurring. -->

<!-- Supported file formats: FixedLength, VariableLength -->
<!ELEMENT FixedLength ((Length | RecordDelimiter)?,
((FixedPrimaryKey+, FixedColumn*) | (FixedColumn+)),
ForeignKey¥*) >

<!ELEMENT FixedColumn (Name, Description?,
AlphaNumeric | Date), Map*, FixedRange)>
<!ELEMENT FixedPrimaryKey (Name, Description?,
AlphaNumeric | Date), Map*, FixedRange)>
<!ELEMENT VariablelLength (ColumnDelimiter?, RecordDelimiter?,
TextEncapsulator?, ((VariablePrimaryKey+, VariableColumn¥*) |
(VariableColumn+) ) , ForeignKey¥*)>

<!ELEMENT VariableColumn (Name, Description?,
(AlphaNumeric, MaxLength?) | Date), Map¥*)>
<!ELEMENT VariablePrimaryKey (Name, Description?,
(AlphaNumeric, MaxLength?) | Date), Map¥*)>

(Numeric |

(Numeric |

(Numeric |

(Numeric |

<!-- Description of the entity supplying the data.
-—>
<!ELEMENT DataSupplier

(Optional)

(Name, Location, Comment)>

<!-- The first Media will contain index.xml.
process each media listed -->
<!ELEMENT Media (Name, Command*,

Importing will

Table+, Command*)>

<!-- Elements common to FixedLength & VariableLength are
propagated to Table. -->

<!'ELEMENT Table (URL, Name?, Description?, Validity?, (ANSI |
Macintosh | OEM | UTF16 | UTF7 | UTF8)?, (DecimalSymbol,
DigitGroupingSymbol) ?, SkipNumBytes?, Range?, Epoch?,
(VariableLength | FixedLength))>

<!-- ForeignKeys denote joins or relationships between
tables. To successfully join two tables make sure both the
PrimaryKey and the referenced column (foreignkey) are of the
same datatype.

Results are undefined when joining two tables with different
key datatypes. Most likely an error will occur. -->
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Version 1.0 vom 10. Mai 2002 (6.6.2002)

Version 1.1 vom 1. August 2002

<!ELEMENT ForeignKey (Name+, References)>

<!-- Maps data from 'From' to 'To'
ie. From To
True 1
True -1
False 0

A map is basically an associative container.
Take caution that 'From' is of the same type
as the column datatype.

<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table validity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types -->

<!ELEMENT ForeignKey (Name+, References)>

<!-- Maps AlphaNumeric columns from 'From' to 'To'
ie. From To
True 1
True -1
False 0

Basically, a map is an associative container.
The standard implementation only supports
AlphaNumeric datatypes. The following
conversions are NOT supported.

Numeric -> AlphaNumeric
Date -> AlphaNumeric
AplhaNumeric -> Date
AlphaNumeric -> Numeric

-->

<!ELEMENT Map (Description?, From, To)>

<!-- Documentation for table validity. -->
<!ELEMENT Validity (Range, Format?)>

<!-- End Complex Types -->

Tabelle 48: Gegentberstellung Beschreibungsstandard Version 1.0 und 1.1
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